Excel Basics for SLA Research

Microsoft Excel is an excellent tool for managing participant records and data. It is also useful for creating graphs and running simple statistical analyses. This training will walk you through the basics of excel using real and modified data. Hopefully, by the end of the training, you will be able to use enough of Excel’s basic functions to use it in your own research.

Basic Design and Setup
To begin our training, let’s open our Workbook (Excel Training Workbook.xls) and look at the basic design of the program and work with some of the basic functions.
_____________________________________________________________________________________
Let’s look first at the most important parts of Excel’s User Interface:

The Ribbon: The first thing to notice when you open the excel sheet is that the setup is very similar to that of other Microsoft Programs with the “Ribbon” at the top, which organizes its basic functions into categories. If you are familiar with Word or Power Point, there will be some overlap with where basic functions are found.

Column/ Cell Labels: You should also notice that along the sides of the main window are labels for the columns and rows. Columns are listed with letters and rows are listed with numbers. Individual cells are named by the column, then the number. For example, A1 is the cell in the top left-hand corner of the worksheet.

Formula Bar: Just above the column names is the formula bar. When you enter data or formulas into a cell, they will appear in this window. This bar is important for two reasons: 
(1) If you want to make a change to something you’ve typed in a cell (e.g. text or formulas) without changing the entire contents of the cell, you will need to click here first; 
(2) If you have entered a formula into a cell, Excel will display the results of the calculation in the cell itself, but the formula will be displayed in the function bar.

Worksheets: Along the bottom row are several tabs that have names (by default these are named Sheet 1, Sheet 2, etc.). These are different Worksheets. You can use these different worksheets to divide up your data. Personally, I like to use them to separate tasks from each other. 
_____________________________________________________________________________________

Now let’s look at the basic formatting tools that will allow you to format data easily so that it is easier to look at or gives you quick information about the data. At this point, we’ll start modifying the training spreadsheet, so that you can get a feel for how each of the functions work.

Adjusting Column Width (or Wrapping Text): If you have text that doesn’t fit in one of your cells, you may want to adjust the column width. To do this, move your mouse to column labels at the top of the spreadsheet and find the border between the column you wish to adjust and its neighbor to the right. Simply click and drag this border to adjust the width. 

Alternatively, you can right-click the column, choose “column width” from the drop-down menu, and increase/decrease the width accordingly. This is more difficult because you can’t see how much you’re adjusting the width, but it can be used to adjust multiple columns at once.

[bookmark: _GoBack]In the “LangBack” Worksheet: There is text cut off in row 1 of columns H, L, and M. Adjust the cell width so that all of the text is readable.

If you have a large amount of text in one cell, you may want it to appear on multiple lines. To do this, go to the “Home” tab on the ribbon, and click “Wrap Text.”


Changing Column/ Row / Cell Color: Sometimes it is easier to identify trends in your data or keep track of participants by highlighting cells, columns, or rows different colors. I like to separate my variables from my data by shading them gray. First you will need to select which cells you want to shade. To highlight shade a single cell, select only that cell. To select a range of cells, simply click on one cell, and drag your mouse to highlight the rest. To select a whole column/ row, click on its letter/number to highlight it. To select multiple columns, you can click and drag a range of column, row numbers.

Next, simply use the color tool in the “Home” tab (it looks like a paint bucket) to select the color you want. The selected cells will change to the color you select.

 In the “LangBack” Worksheet: Separate your variables and raw data by shading column A and row 1 gray. In the “Pretest” and “Posttest” Worksheets: Shade columns A, W, X, and Y, and row 1 gray.

Adding Borders to Columns/ Rows/ Cells: You may (also) want to separate your variables by using cell borders. Use the same selection procedures above, and then use the border tool in the “Home Tab” (it is found under the font boxes and looks like a few cells with borders. Select the type of border you wish to apply.

In the “LangBack” Worksheet: Apply a right-border to column A and apply a bottom border to rows 1 and 36. In the “Pretest” and “Posttest” Worksheets: Apply a right-border to column A, a left border to column W, and a bottom border to rows 1 and 36.

Adding Comments: When reviewing your data, you may want to leave a note to yourself about something. To do this, select the cell you want to leave a note for. Then click on the “Review Tab” in the ribbon, and click “New Comment.” Type your comment and click anywhere in the worksheet to save it.

 In the “LangBack” Worksheet: Add a comment to cell J21, saying that this person has too much foreign language experience.

Freezing Panes: It is usually helpful to keep your headings and your subject numbers in view at all times. To do this, you’ll use the “freeze panes” tool. When you use this tool, the cell that you select will be the first one to disappear. The column immediately to the left, and the row immediately above it will be frozen. So for example, if you want to freeze the first column and the first row, select cell B2. Then, find the “freeze panes” button in the “View” tab of the ribbon, and click “freeze panes.” Now, when you scroll, these columns/rows should always be in view:

 In the “LangBack” Worksheet: freeze the first column and first row of your sheet. Make sure to scroll right/ down to check if this worked. Repeat this for the “Pretest” and “Posttest” worksheets.


Creating / Arranging Data
Inserting Rows/ Columns: If you need to insert columns to add more data, you can do so by right-clicking the row/ column where you would like your new data to be, and clicking “Insert.” If you are creating a new column, the rest of your data will shift to the right one column. If you are creating a new row, your data will shift down.

 In the “LangBack” Worksheet: Insert a new column in column B. Call this column “Include” (If you are not sure how to enter this label, see the steps below under Entering Data.)

Entering Data: To enter new data, all you have to do is select the cell where you want the data, type in a number/ text and hit the enter button. If this data needs to be edited later you can (a) repeat the same procedure (this will delete the entire contents of your cell) or (b) click in the formula bar to edit the cell contents. 

If you would like to enter the same information for multiple cells, you can enter it once, and then use the mouse to click and drag the data from the bottom right hand corner of the cell to fill in the rest of your column or row.

 In the “LangBack” Worksheet: Enter the number “1” for all of the cells in Column B.

Copy/Paste Data: If you need to copy and paste data, you can use the same basic procedure as in other MS office programs. Select the data and right click on it to bring up the dialog box, and click copy. Then right-click the cell you want to paste into, and select paste. (You can use the keyboard shortcuts CTRL+C and CTRL+V as well if you are used to those).

NOTE: BE VERY CAREFUL WITH COPY AND PASTE, ESPECIALLY WHEN YOU ARE USING FORMULAS: When you copy and paste formulas, you will need to “Paste Special” or your data will be wrong. When you “cut” and paste data that is used in a formula, you will change that formula reference the new cell. We will talk more about this later, but as a rule, I never use “cut”; I always use “copy”.

We will practice copy/paste later in this training.

Sorting Data: Sorting data is one of Excel’s best features, especially when you are managing a large study. The first thing to do is select the data you wish to sort. Most of the time, you will be sorting all of your data. I like to use the CTRL+A keyboard shortcut (press it twice) to do this, but you can also select the data with the mouse. 

Then, find and click the “Sort” button in the “Data” tab on the “Ribbon.” This will bring up a dialogue box. In the upper-right hand corner is a check box for “My data has headers.” If you have named your columns in Row 1, check this box. If not, leave it unchecked. Then you can select which column you would like to sort by in the drop-down box in the main window. If you want to sort by multiple factors (say Gender, then age), click “Add level” in the upper left hand corner, and then select your second factor. Click OK to complete the sort.

 In the “LangBack” Worksheet: sort for the Gender and then the age of the participants.


Working with Raw Data
We’ll now turn to working with quantitative data. One of Excel’s major selling points is the ability to perform mathematical functions. In this section, we’ll go through the basics of entering formulas and I’ll show you some of the more common formulas I use.

Formulas can be entered either manually or through a dialog box. I’ll show you the “dialog box” method for each formula in this training. The manual way of doing things is quicker if you know what you’re doing, but can be confusing if you’ve never worked with the formula before. Either way, you need to pay good attention to the number and type of arguments in each formula for them to function properly.

=SUM: The SUM function adds together a range of numbers. There is only one argument required for SUM: the range of numbers. To use SUM, first place your cursor in the cell you want your formula in. Then click on the “fx” in the formula bar, and select SUM from the main window (you may need to change the category to “ALL” in the drop-down box above the main window). Then, use your mouse to select the range of cells you wish to add up. To select numerous individual cells, press and hold the CTRL button. Click OK. The number should appear in the cell where you put the formula.

	NOTE: If you want to check or change the range of cells, click on the cell with the formula, and then click in the function bar. The selected range of cells will appear in a colored box. If you need change the range, use the mouse to drag the box to the desired range, and press enter. Your formula will update automatically.



In the “Pretest” Worksheet: In W2, use the SUM formula to create a score for the odd numbered items of the pretest. The item numbers are listed in row A: so item 1 is in cell B2, item 3 is in cell D2, etc. In X2, use SUM to create a score for the even numbered items. In Y2, use SUM to create a score for all of the items in the pretest.

Copy/ Paste Formulas: You can use the same procedures to copy/ paste formulas as you did for data. You can also “drag” the formula to other rows/ columns by grabbing it at the bottom right-hand corner and dragging it to the other cells.

 In the “Pretest” Worksheet: Copy your formula in W2 to cells W3 to W36, copy the formula in X2 to X3 through X36, and copy the formula in Y2 to Y3 through Y36. 

	Notice that the “range” of each function operates relative to the cell it is placed in. So your SUM function adds up cells in Row 2 when the function is found in Row 2, but it adds cells in Row 3 when placed in Row 3. This is why you have to be careful when copying formulas. Use the method above to double and triple check your formula range if you need to.



=AVERAGE: The AVERAGE function works just like the sum function. To compute an average, click on the “fx” in the formula bar, and select AVERAGE from the main window. Then, use your mouse to select the range of cells you wish to average. To select numerous individual cells, press and hold the CTRL button. Select OK to compute the average.

In the “Pretest” worksheet: Use AVERAGE to compute the average for your SVO, OVS, and Total scores (columns W, X, and Y). Use row 37. Remember, you can use copy/paste to compute the 2nd and 3rd averages. 

=STDEV: The STDEV computes the standard deviation for a range of cells and works just like the sum and average functions. To compute an average, click on the “fx” in the formula bar, and select STDEV from the main window. Then, use your mouse to select the range of cells you are using. To select numerous individual cells, press and hold the CTRL button. Select OK to compute the standard deviation.

In the “Pretest” worksheet: Use STDEV to compute the standard deviation for your SVO, OVS, and Total scores (columns W, X, and Y). Use row 38. Remember, you can use copy/paste to compute the 2nd and 3rd standard deviations. 

 Now that we have computed all of our scores for the Pretest, let’s copy ALL of the formulas into the “Posttest” worksheet. We can do this because the Pretest and Posttest worksheets are set up in exactly the same way and the cells needed to compute each score are identical. Be very careful when doing this operation in your own work; when in doubt, compute each score a second time.

=COUNTIF: There’s one more useful function to learn before moving on. The COUNTIF function counts number of cells that meet a certain criteria. So if, for example, you are interested in how many Males and Females you have in your participant pool, you can easily count them. COUNTIF has two arguments: (1) the range of cells, and (2) the criteria (in other words, what you’re counting). Use the “fx” button to open the dialogue and select the range of cells you are interested in. Then, move your cursor to the “criteria” box and type in what you want to count. For example, if you are counting the number of Males, you would write in “M.” If you are looking for the number of participants older than 20, type in >20 (“>” is greater than, “<” is less than, “>=” is greater than or equal to, and “<=” is less than or equal to).

In the “LangBack” worksheet: Create a count of the number of Men and Women in the study. Then create a count for the number of participants older than 20, and the number of participants 20 or younger. 
	


Visualizing Data
Excel also makes it relatively easy to make graphs and charts to visualize your data. We’ll make a “column” graph out of the data that we have in our example file. Then we’ll see how we modify and format that chart so that it can be easily copied to a PowerPoint or Word Document.

Making a Table: The first thing you need to do before you can make a graph/chart is to distill your data down to a table. This means that you need to have a clear sense of your data’s variables. In the example file, I’ve created the skeleton for a table in the worksheet “Table, chart”. In this table, you can see that I have two main variables: Time (pretest, posttest), and Score Type (SVO, OVS, Total). Once you have the skeleton for your chart, you need to copy the relevant data into the corresponding place in the table.

But doing this isn’t as easy as regular copy/paste. Remember your scores were computed with a formula, and if you copy that formula to the table, it will try to compute a score with non-existent data. Therefore you need to Paste Special

Paste Special: Paste Special allows you to paste just the values from a particular cell. You need this if you are trying to use your data outside of its original context. To paste values only, first copy the cell as you would any other, then right-click where you want to paste your date, and click “Paste Special.” This will open a dialogue box. Under the “Paste” heading, click “Values.”

Depending on the way your table is set up, you may need to transpose your data as well. This means that you need to convert something that was in a row into a column. For example, you will notice that the three pretest/posttest scores are in a row when they were computed, but they are in a column in the table we just created. If your data needs to be transposed, click the “Transpose” checkbox at the bottom of the Paste Special dialogue box.

When you are done selecting your options, click OK.

Paste the Pretest and Posttest Scores from their worksheets into the table “Skeleton” in the “Table, Chart” Worksheet. You can do this by copying/pasting cells one at a time, or in a two-step process using the “Transpose” feature.

Creating a Graph from your Table: Once you have your table, making a graph is easy. Simply select your entire table, and click the type of graph that you would like to make from the “Insert” tab on the ribbon. The graph will show up automatically. There are lots of options here, so you might play around with it to see which one fits your data best.

Create a 2-D column graph from the table. 

Modifying the Data Selection: If you need to modify what data is included in your graph, you can do so by clicking the plot area of the graph, and then clicking/dragging the colored boxes that come up around your data. 

The most common modification you will need, though, is switching what variables are on the X axis vs. what variables are in the legend. To do this, Right click inside the plot area of the graph, and click “Select Data.” Then click the button “Switch Row/Column.”

Switch the Rows/Columns so that Pretest and Posttest are in the X-axis.

Modifying the data / Modifying Labels: If you need to modify data or labels after you’ve created the chart, all you have to do to change it is change the corresponding data point/ label in the original table. 

Change the SVO Label to “Subject-First” and the OVS Label to “Object First”

Formatting the chart:
Text size/colors: Changing the text size or colors for your labels is also relatively easy to do. To change the text, simply click on the text you want to change, and then use the font section of the “Home” tab in the Ribbon to make your changes. If you are changing size, I recommend you use the “Size Up/Down” buttons for incremental changes instead of guessing what size is best.

Increase the font of labels for the the X-Axis, Y-Axis, and Legend.
 
Chart colors: To change the colors of the chart, you’ll first need to click on the “series” that you want to change (i.e. Subject-First Items). After doing this, find the “shape fill” icon in the “Format” tab in the Ribbon (note: the format tab is only visible when you’ve selected the graph). Click on the “shape fill” icon and select the color you want. You can also give your series a colored outline if you like, using the “Shape Outline” tool. Repeat this process for each series you would like the change.

Change the Subject-First series to light blue, change the object-first series to orange, and change the total series to purple.

Axis intervals: You may want to change the intervals in your axes. (Note: In this example, only the y-axis has a continuous variable, so it is the only axis that can be changed in this manner.)  To change the intervals, double click on a number in the axis. A dialogue box should open showing a series of axis options. Here, you can change the axis’s minimum and maximum values, as well as their major and minor intervals. To do this, first switch the radio button from “Auto” to “Fixed” and type in the value that you would like to use for each option. There are more options here if you choose them; one that might be useful is the “minor tick mark type,” which is set to “none” by default. If you would like smaller intervals to be visible, change this option as you wish.

Change the Y-Axis major unit to 5. Change the minor unit to 1, and change the minor tick type to “outside”

Adding Error Bars: Adding error bars can be somewhat tricky, but can be very useful in visualizing where there are differences in the data. Sometimes, error bars are added using the Standard Error in a function. Other times, the Standard Deviation is used. We’ll use the Standard Deviation since we’ve already computed those values.

First, you’ll need to make a table skeleton identical to the one you used for your chart. I’ve already created the skeleton for you, but you’ll need to copy in the values for standard deviation. Remember to use the paste special “values” only and “transpose” functions to do this.

Copy the Standard Deviations into the table in the worksheet “Table, Chart.”

One you have your standard deviation table complete, click on plot area of the chart. Then, find the “Error Bars” button in the Ribbon’s “Layout” tab. Then click “More Error Bar Options.” You will then see a dialogue box asking which series you’d like to add error bars to. Select the first one in the list. 

A series of options will appear in a dialogue box. The first section asks what type of error bar you want. By default, “Both” and “Cap” are selected. These options are likely what you want. In the bottom part of the box, under “error amount” select “Custom” and click the “specify value” button. You’ll then select the range of cells that correspond to the series you selected. For example, if you selected the “subject-first” series you’ll select the pretest SVO and posttest SVO cells. Do this for both the Positive and Negative Error Values. Repeat this procedure for each series in your data.

If you need to modify the error values, simply change their value in the standard deviations table.

Add in error bars for the Subject-First, Object-First, and Total columns in the graphs.


Analyzing Data with simple T-Tests
Sometimes it can be helpful to get a quick view of your stats before going into a full stats program like SPSS, especially if these programs are unavailable to you. While doing more advanced statistical tests is probably best left to these programs, Excel works just fine for simply T-Tests.

	Before you can actually run statistical analyses, you need to make sure you have the Analysis ToolPak installed. This comes standard with Excel, but isn’t installed by default. To install the ToolPak, go to “Options” in the Ribbon’s “File” tab. When the “Excel Options” dialogue box opens, click on “Add Ins” on the left side. At the very bottom, you will see a drop-down box with the word “Manage” beside it. Make sure that “Excel Add Ins” is selected, and click “Go”. When the “Add Ins” dialogue box opens, check “Analysis ToolPak” and click OK. This will add data analysis tools to your ribbon. 



The first thing that you will need to do in order to run T-Tests is to organize your data so that it is in the same worksheet. To do this, use the paste special (paste “values only”) functions as described previously in this training.

The Data has already been arranged for you. Click on the “T-Tests” Worksheet Tab and use the data found there for the remainder of this training.

Once your data is organized, find the “Data analysis” button in the Ribbon’s “Data” tab. Choose the statistical test you would like to perform. In our example, we’ll choose “Paired Two Sample for Means” because we are interested in how each participant performs on the same test over two testing periods.

When the dialogue box opens, select the window for your first variable range (e.g. Pretest_Total), and use the mouse to select your data. Then, select the window for your second variable (e.g. Posttstest_Total), and again use the mouse to select your data. Then click OK, and the stats readout should appear in a new Worksheet.

Run a paired T-test (Paired sample for two means) comparing the Pretest Total and Posttest total values.

Especially if you are running multiple tests, be sure to label this worksheet or copy the data into an MS Word Document.

Some Advanced Functions:
There are obviously some more advanced functions that can be useful to you in conducting your research. The most basic of these is the =IF function. Another function that will be useful is the =INDEX(MATCH()) function. I have also found it helpful to use the =SUM and =COUNTIF Functions. Each is described below.
	
=IF()): This function is extremely useful for recoding data. It can also be combined with other functions in many, many ways. We’re going to use it to recode the gender data. Sometimes this is necessary when running certain statistical tests, so it is helpful to know how to do it.

Look at the “LangBack” sheet. Column D is labeled “Gender Recode”. We are going to recode the gender column so that females are coded “1”, and males are coded “2”. Select cell D2. Then begin by clicking the fx button and selecting “IF”. 

The first box is labeled “Logical_test”. This specifies the condition that should be met. In this case, we want to know if the “Gender” column is coded “F” for “female”. So we will type C2=”F” in this box. Notice that the “F” is in quotes. This is because it is text; numbers or cell references don’t need quotes. Notice also, that the word “True” appears next to the Logical_test box. This is because the cell C2 is coded “F”. 

In the “Value_if_true” box and the “Value_if_false” box, we specify how we want the items to be coded. If the Logical test is true, the function returns the value in the first box. If it is false, it returns the value in the second box. Since we want to code “F” as 1, type in the number 1 in the first. In the second box, type the number 2. Press “OK”. 

You can now copy this formula (or drag it) into the rest of the cells, and your data is recoded.

· In the “Gender Recode” column, Recode Gender (F, M) as numbers, (1, 2).

The =IF function can also be used to find out if a value is greater or less than a specified amount. This can be extremely useful if you have continuous data that you want to sort into categorical data. 

Look at the =INDEX(MATCH) KEY worksheet. In column B, we have ratings for phrases in Dutch (i.e., continuous data). Say you want to sort these into two categories: greater than 3 or less than 3. We can “recode” this continuous data just like we did above. 

For this example, I’ll show you the manual way. Keep in mind, that the manual way is just like using the fx button. The only differences are that (a) excel gives you a little help, and (b) the values that you would enter into “boxes” are separated by commas.

You’ll start by typing the functional operator =IF( into cell D2. 

=IF(

You’ll then type in the logical condition. In this case, you want to know if the number in B2 is greater than 3. So type in the logical condition “B2>3”. 

=IF(B2>3,

Now you need to specify the true/ false values “1” and “0”. 

=IF(B2>3, 1, 0)

You can now copy this (or drag it) into the cells below. Your data is now ready.

In the column “Greater than 3”, Recode Notional as the categories 1 and 0

Let’s look at a more complicated way to do this. This involves embedding functions. Let’s say you don’t want to recode into the categories 0 and 1, but rather “High” and “Low”. Let’s say you also want to sort into these categories depending on whether the value is higher or lower than the average. 

To do this, we could first compute the average, and then plug that into the equation. But what if we change a number in the “Notional column”? We would have to redo the average and rewrite the formula. It’s easier to make an embedded function.

We’ll go the manual route again. Start by typing the function operator into E2. 

=IF(

Then we type the logical condition. In this case, we want to know if B2 is above the average. Type in B2> first. Then we’ll work with the embedded function. 

=IF(B2>

The embedded function is the average of column B. We can type this in, just like we would with a normal average function, just without the “=”. 

AVERAGE(B:B)

So put the larger function and the embedded function together.

B2>AVERAGE(B:B),


Now, we need to specify the true / false values. Since we want to return text, use quotations and type “High” and “Low”. Then close it out with parentheses. This is the full function

=IF(B2>AVERAGE(B:B), "High", "Low")

In the column “High/Low”, Recode Notional as the categories “High” and “Low”




	
=SUM(COUNTIF()): This embedded function is extremely useful, especially if you are using Excel to grade your tests for you. In my research, I have a pretest with 20 Yes/No questions, but only a few of them are scored. To grade the tests, I simply entered all of the answers: “Y” for “Yes” responses and “N” for “No” responses. I then used this embedded function to count if the participants had put in correct answers. In order to use this function, you’ll need to use the manual entry mode, though, so it’s more complicated. 

Let’s look at the example file in the sheet “=SUM(COUNTIF()).” Let’s say I want to know the number of correct responses for the SVO items 1, 5, 10, 15, and 20. And let’s say that the correct answer for 1, 10, and 20 is “Yes”, for 5 and 15, it’s “No”. I can use COUNTIF to count the correct responses, and SUM to count them. So that things are tidy, I can embed the functions.

So I’ll start by typing in the =SUM function:

=SUM(

Then, I’ll want to add a =COUNTIF function for the first item I’m interested in, item 1. Remember, the correct answer is “Y” so that’s the criteria we use. We’ll enter the cell first, followed by a comma, and the letter Y in quotations. Close the function off with parentheses:

=SUM(COUNTIF(B2, "Y")

Now you can use the “+” to add as many =COUNTIF functions as you need. Close the whole thing off with parentheses at the end.

=SUM(COUNTIF(B2, "Y")+COUNTIF(F2, "N")+COUNTIF(K2, "Y")+COUNTIF(P2, "N")+COUNTIF(U2, "Y"))

You can now copy/paste that formula wherever you want, just as with a regular =SUM function. Once you do that, congrats!: You’ve just turned a complicated grading job into a simply data entry job.






	
=INDEX(MATCH)): =INDEX(MATCH)) can be extremely useful for adding data that exists in another spreadsheet. It is particularly useful when you have a set of data and need to code that data according to conditions in a stimuli list. The example shown here is a case, where the item number and notional data need to be added into the data sheet. Fortunately, we can use =INDEX(MATCH)) to look up the “phrase” used in each trial, and insert the corresponding data into our spreadsheet.

For this example, we need two worksheets: “=INDEX(MATCH) Data” and “=INDEX(MATCH) Key.” We are going to look up the item and notional information from the Key and insert it into the Data (in columns J and K) based on the “phrase”. Note that the “phrase” is found in the leftmost column of the “Key” Worksheet.

To do this, we start with =INDEX().First select cell J2; this is where we’ll insert our first “item” data. We’ll have to go the manual route here since we have an embedded function.

First, type the functional operator. 

=INDEX(

The first argument is the “array”. This refers to the key, so we need to specify where the key is. This is accomplished most easily by clicking on the cells you need. Firs click on the “=INDEX(MATCH) Key” worksheet, and select columns A through E (you can do this by clicking on the column labels and dragging across the top). Click back in the function box and type a comma to move to the next argument. The function should look like this:

=INDEX('=INDEX(MATCH) Key'!A:E,

The next argument is the row. Here, we specify which row of the key we want. In order to do this, we will need to specify the value to look up. This is where MATCH comes in. We’ll work just with MATCH for now.

MATCH(

Now we specify the value to be looked up. We want to look up the phrase from the Data sheet. So click back to the data sheet and select cell I2. Type a comma to move to the next argument.

MATCH('=INDEX(MATCH) Data'!I2, 

The next argument is the lookup array. Here, we tell excel where to find the phrase. This is back in our key. Click over to the Key sheet (again), and select column A, where the phrase is. Type a comma. 

MATCH('=INDEX(MATCH) Data'!I2, '=INDEX(MATCH) Key'!A:A

The next argument is match type. Here, we’re looking for an exact match, so we type a 0. Close the parentheses to finish the MATCH function.

MATCH('=INDEX(MATCH) Data'!I2, '=INDEX(MATCH) Key'!A:A, 0)

We’re returning to the INDEX function now. Type another comma. This moves us to the next argument in the INDEX function. Now we specify which column we want from the Key. Since we want the item number, and since that data is in column C, the third column, we type the number 3. Close the parentheses and press enter. The whole function looks like this:

=INDEX('=INDEX(MATCH) Key'!A:E, MATCH('=INDEX(MATCH) Data'!I2, '=INDEX(MATCH) Key'!A:A, 0), 3)

It’s really less complicated than it looks because the names of the worksheets are complicated. Sorry! It really looks something like this:

=INDEX('Key'!A:E, MATCH('Data'!I2, 'Key'!A:A, 0), 3)

In plain English: Create and Index from the Key, which is in the ‘Key’ worksheet in columns A through E. Now, look for the phrase I gave you in “Data, I2”. Find that phrase in column A in my ‘Key’; this should be an exact match. Now, give me the value next to the phrase (it’s in column 3).

You can now copy this (or drag it) below.

 Add in the item information

Now that you have the function, you can copy it into column K to get the notional data too. BUT! We have to do a few things before we can do that.

Go back to your formula that is in I2. We need to “lock” the location of the Key. We do that by adding dollar signs to all of the columns on the Key sheet. We also have to “lock” the column of the lookup value (column I):

=INDEX('=INDEX(MATCH) Key'!$A:$E, MATCH('=INDEX(MATCH) Data'!$I2, '=INDEX(MATCH) Key'!$A:$A, 0), 3)

Now you can copy the formula from I2 to J2. Notice that K2 returns 47, the same value as in I2? In order to get the Notional data, we need to change the column in our Key. Notional data is in column B, or the second column in our data. So we change the number “3” at the end of the formula to “2”.

=INDEX('=INDEX(MATCH) Key'!$A:$E, MATCH('=INDEX(MATCH) Data'!$I2, '=INDEX(MATCH) Key'!$A:$A, 0), 2)

NOW you can copy (or drag the formula down) to all of the other cells. You now have all of the data you need in the right place!
 





